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BluePrint QuickStart 
This QuickStart is a tutorial that is intended to help you get up and running quickly with 
BluePrint PCB.  The tutorial includes and references design data that you will use to 
create documentation.    
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We cover the basics here.  For more in-depth information on BluePrint functionality, 
please see BluePrint’s online Help or contact us at sales@downstreamtech.com.   

Note:  You may find it easier to print out this tutorial then to move back and forth 
between this tutorial window and BluePrint as you follow the QuickStart instructions. 

About the QuickStart Demo Files 
The QuickStart demonstration files can be found in the BluePrint Demo installation 
directory under a folder named “Demo Files”.   The default installation directory is:  
“C:\Program Files\DownStream Technologies\BluePrint-PCB 1.5 Demo\”.   Since you 
may have chosen another location for the installation we refer to the installation directory 
as “Your BluePrint Installation Folder”. 

Overview/Philosophy 
BluePrint PCB helps you to quickly create PCB documentation by importing your PCB 
CAD data and using that data to automatically generate PCB documentation images.  
BluePrint can automate the creation of drill charts, drill patterns, Layer stack-ups, bottom 
and topside PCB views, parts lists, and much more.  Any of these images can be 
customized to meet your special documentation requirements.  Simply create a drawing, 
import a cad file, drag and drop PCB documentation images onto your drawing sheet 
and create your documentation. 

Learn the User Interface 
BluePrint’s user interface is similar to that of other Microsoft Windows applications.    

Menus and Toolbars:  Menus and toolbars can be found across the top of the 
application.  Toolbars are context sensitive and will appear when you perform a 
corresponding action.  You can also make them visible or hidden through the View – 
Toolbars menu. 

Workspace:  The main workspace in the middle of the application is where you edit and 
preview your documentation.   You can also select a design view which will allow you to 
view and query the CAD design data you have imported.   

Tool Palettes:  On the left side of the application you will find the Tool Palettes.  Tool 
Palettes are organized by function and contain drawing elements that you can drag and 
drop onto your drawing sheet.  Common elements are drawing elements that you might 
use on any type of drawing, such as a title block or drawing border.  The Fabrication 
Drawing Palette contains drawing elements that you would typically put on a Fabrication 
drawing, such as a drill chart, drill pattern and a layer Stack-up.  And you will find a 
similar grouping of drawing elements in the Assembly Drawing Palette. 

Task Pane:  On the right side of the application you will find the Task Pane.  The Task 
Pane allows you to quickly create a new documentation package or drawing.  The Task 
Pane also will show you files you import into BluePrint and allow you to work with these 
files.  Bitmaps, WORD documents, Gerber files, DXF files, etc…. can all be imported 
and viewed in the Imported Files Task Pane.    
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Main User Interface Layout 

 

BluePrint’s Documentation Hierarchy 
A BluePrint file represents a documentation release package.  A release package can 
contain several drawings.  A drawing can be a Fabrication drawing, an Assembly 
drawing or a Custom drawing.  Each drawing can have several sheets.  Each sheet can 
contain several drawing elements.  Selecting the Contents View button on the Tool 
Palette toolbar will let you see a release packages hierarchy. 

Create a Document Release Package 
1. Invoke BluePrint 
2. Select “Start Your First Documentation Package” from the Start Page.  Or select 

File – New – Package from the main menu.  Or select “Create a new release 
package” from the Task Pane. 

Create a New Drawing 
3. Select “Create a new drawing” from the Task Pane or select File – New – 

Drawing from the main menu. 
4. In the Task Pane you will see three choices (“Fabrication Drawing, Assembly 

Drawing and Custom Drawing”).  Select Fabrication Drawing.   

Main menu bar

Dockable tool bars

Task Pane

Document Viewing windows 

Screen Splitter

Tool Pallet 

Drawing Elements
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Import a CAD design file 
5. Select File – Import – PADS ASCII from the main menu and browse to select 

“Your BluePrint Demo Installation Folder/Demo Files/BluePrint Demo rev1.asc” 
6. Select the Design tab in the Workspace window and you will see the imported 

design data.  Select the Edit tab on the Workspace window so you can start 
creating a Fabrication drawing. 

Create a Fabrication Drawing  
7. Select the Common Elements Tool Palette. 

8. Drag and Drop the Sheet Border, Title Block and Revision Block drawing 
elements onto the drawing sheet. 

Place Drill Pattern  
a. Select the Fabrication Drawing Tool Palette.   

b. Drag and Drop the Drill Pattern drawing element onto the drawing sheet. 

c. Double Click the Drill Pattern to bring up its format dialog and un-check 
the Lock Scale control. This will allow you to resize interactively.  Select 
OK in the format dialog to close it. 

d. Resize the Drill pattern by dragging its grab handles.   

e. Note that BluePrint takes a “view” of the PCB with pre-selected display for 
the Drill Pattern 

9. Click the ZOOM SELECT icon  on the navigation tool bar.  This will zoom into 
the selected item (the Drill Pattern) and allow you to view the drill symbols more 
clearly.   

10. RMB on the DRILL PATTERN click on Format from the pop up (or double click 
on the Drill Pattern) 

a. The format dialog controls the behavior of the PCB view including scaling 
and display of data.  

b. Select the PCB CAD Data tab to view the display settings for this PCB 
View.  Note that the Board Outline and Drills are selected.   

c. Select Cancel in the Format PCB View dialog. 

11. Click PREVIOUS VIEW  button to return to full screen or click the full screen 

icon  on the Navigation toolbar. 

12. Place the Drill Chart , above the title block 

a. The drill pattern and drill chart are both driven by the CAD data 
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13. Select the Fabrication Drawing Manager  from the Fabrication Drawing 
Tools Palette. 

a. On the Drill Symbols Pane , add a tolerance “+/- .002” to the drill 
symbol table “POWERPCB AUTO-ASSIGNMENT” which is the default.  

b. Save the Table under a new name using the SAVE TABLE AS… button 
on the right.  

c. Your new table has been now set as the default table. 

d.  Click Preview and you will see the tolerances added to the drill chart. 

 

 
 

Fabrication Drawing Manager with tolerances added and Drill Symbol modification in 
process.  

e. Drill symbols can be changed using the Fabrication Drawing manager.  
You can also set up company standards for all hole sizes with tolerances 
and store them away under one or multiple drill tables and use the stored 
table on any design file regardless of where it came from.  This helps 
ensure consistency with all documentation 

f. Close the Fabrication Drawing Manager 
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Place a Layer Stack-up 

14. LMB on the Layer Stack-up  element in the Fabrication Drawing Tool 
Palette. 

a. The Layer Stack-up dialog will appear.     

b. Click the Magnify Button to see the template that represents the layer 
Stack-up in BluePrint. 

c. This template is a repeated block template.  The areas between the 
Yellow lines on the template are repeated areas that automatically repeat 
themselves for each instance found in the PCB CAD database.  In this 
case all the layer records. 

Close Magnify View. 

d. Switch to the DATA tab.  This is the data that was imported with the PCB 
CAD design and will be used to automatically generate the layer Stack-
up. 

e. Click OK on the layer Stack-up dialog. 

f. Place Layer Stack-up on lower left corner of drawing. 

15. BluePrint merges the CAD data with the graphical template to create an accurate 
Layer Stack-up detail.  

Edit a Drawing Detail 

16. Drag and Drop the Finger Chamfer  drawing element from the Fabrication 
Drawing Tool Palette. 

a. Zoom into the Finger chamfer detail with the FIT SELECTION icon on the 

View toolbar  

b. Click on the Finger Chamfer element, display the right mouse button 
menu and select Edit Detail. 

c. The Finger Chamfer is a BluePrint “detail”.  Details are containers with 
information that can be modified and formatted. 

d. Select items while the detail is open to see that items are “touchable” 

e. Draw a circle in the upper right corner of the detail. To create a circle, 
click Common Elements, then drag and drop the resizable circle onto the 
sheet. 

f. Click outside the Finger Chamfer Detail when done and View the entire 
sheet. 

g. Reposition detail to see that data (circle) moves with it. 
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Auto Dimensioning 
17. Dimension the board outline using the Auto Dimension Icon  for the 

segments shown below.  The Auto Dimension Icon is on the Drafting Toolbar and 
is located at the bottom of the BluePrint Application window.  If the Drafting 
toolbar is not visible, select View – Toolbars – Drafting Toolbar to make it visible. 

a. Select the Auto Dimension Icon 

b. Move the cursor over the edge of the Drill Pattern board outline.  You 
should see it highlight. 

c. Select with the left mouse button, hold down the button and drag the 
cursor away from the board outline.  The dimension will be created. 

d. Release the LMB and the dimension will be placed. 

18. Click on the Drill pattern and move it.  The dimensions are associated with the 
Drill pattern and will move with it. 

19. Resize Drill pattern with grab handles.   

a. The dimensions adjust accordingly 

b. The dimensions don’t change based on PCB Image scale 

20. Drag and drop a Triangle  Auto shape from the common elements 

21. Dimension the triangle using the Auto dimension tool 

22. Resize triangle, rotate it, and move it to see associative dimensions 

a. The dimensions adjust and change based on the triangle scale. 

b. Delete the triangle 

Create Notes  

23. Drag and Drop the Fabrication Notes  from the Fabrication Drawing Tool 
Palette.   

a. Custom notes can be set and stored under pallet element buttons 

b. Resize the note block using the sizing handle on the mid right of the note 
block. BluePrint’s built in word process features automatic word wrap 
when resizing text and notes. 

24. ZOOM SELECT note block: 

a. Place your cursor over and Select the text in Note 6.  

b. In Note 6 click on the word “imageble” which should appear as a spelling 
error. BluePrint has on-line spell checking. 

c. While the cursor is still placed within the word imageable RMB click and 
select Spelling from the RMB, you will see a list of spelling suggestions 
contained in the dictionary. From that sub menu click Spelling… again. 
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You will get the spelling dialog. You can add PCB orientated words to the 
dictionary.  

d. Click on the border of the Note Block to select the entire Note block 

e. From the Noteblock tool bar, click the split note block icon. . 

f. Click on the newly split note block section for the same sheet. 

g. Add additional notes from the Note block tool bar. . 

i. The notes are continued on the sectioned note block but both 
sections comprise the entire note block 

h. Select Note 3 and click on the callout icon  in the note block tool bar 
to place a symbol callout linked to the note 

i. Drop the callout (Zoom out a little if needed) on the lower right hole in the 
PCB Drill Pattern view. Pick up the end terminator point (the dot) and 
place it on the hole. Ensure that the hole first highlights before you drop. 
This indicates that the callout is now associated to the hole.  Note: You 
MUST pick up the end terminator point (the dot) of the callout and place it 
on the PCB Image or the association will not occur. 

j. Move the PCB View again (the callout should move with it) 

i. Placing the terminator of a callout associates it to a geometry, 
while moving the entire callout allows you to place the callout and 
snap without making an associations. Moving the terminator back 
outside the PCB View breaks the associations. 

k. Try Ascending/Descending sequencing  on the Note Block Toolbar. 

l. Select note 3 and move up and down in order , then demote and 
promote note   (make child, then make it a parent). The callout stays 
linked and changes with the note. 

m. Delete the Note 2 . The callout automatically changes as the note 
block re sequences itself. 

25. Change to Preview Tab 

a. Preview allows you to see how the documentation will appear in View 
mode and to test out interactive links added to the document 

b. Move mouse over note callout 

c. The cursor changes to indicate a link 

d. Click on callout to display note in link window 

e. Click on the link window 

i. BluePrint creates interactive and live documentation through 
hyperlinks 

f. Close the Link window.  Go to Edit View. 
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Place a Callout 
 

26. Add a Callout Element from the Common Elements Drawing palette and 
place pointer on Fingers as shown below 

 

 
 

 

27. Double click the Callout to open the Callout’s Format dialog, using the Link Tab 
dialog, change the comb box to Details, and click the Finger Chamfer Detail.  

a. Details are catalogued by BluePrint to allow graphical linking and 
identification 

b. Select OK. 

28. Quickly flip to Preview and click on the Callout Link to see Detail in the Link 
Window 

a. It is easy to create live/interactive documentation 

29. You have now created a basic PCB fabrication drawing 

30. Change back to the Edit Tab View. 

Create an Assembly Drawing  
31. Select “Create a new drawing” from the Task Pane or select File – New – 

Drawing from the main menu. 
32. In the Task Pane you will see three choices (“Fabrication Drawing, Assembly 

Drawing and Custom Drawing”).  Select Assembly Drawing.  Enter Part Number 
in the Assembly Drawing dialog and then select OK. 

33. Select the Common Elements Tool Palette. 

Callout location 
Fingers 

PCB 



BluePrintPCB QuickStart  DownStream Technologies, LLC 

Questions?  Email blueprintsupport@downstreamtech.com                       Page 10 of 13 

 

34. Drag and Drop the Sheet Border, Title Block and Revision Block drawing 
elements onto the drawing sheet. 

35. Select the Assembly Drawing Tool Palette. 

a. One of the biggest challenges in PCB documentation is to show top and 
bottom sides of the PCB simultaneously 

i. Cannot be done in PCB CAD 

ii. Can only be done if translated to Mechanical CAD 

a. Gerber => DXF=DXF Import for each layer 

36. Click on the Assembly Drawing Palette. Drag and Drop the Topside and Bottom-
Side View drawing elements onto the drawing sheet. 

a. BluePrint frees up documentation from CAD constraints while leveraging 
all the design intelligence 

b. There is no limit to number of PCB images that can be created from the 
single imported source 

c. Double clicking on a PCB View and see the different tabs for easily 
customizing these views. 

d. PCB Views can be modified and saved as default views for further use. 
For example if you want Pads displayed in the PCB Views. 

 

Place an Exploded View 
37. Select the Assembly Drawing Tools Palette.   Drag and Drop the Explode View 

drawing element onto the Assembly drawing sheet.  The Explode View drawing 
element is made up of a Callout area (the smaller circle) a Pictorial border (the 
larger circle) and a graphical link.   Move the Callout area over one of your PCB 
Views and you will see the Pictorial area being updated dynamically in the 
Explode View.   

38. You can resize if needed by adjusting the grab handles on the callout area and 
pictorial sub elements. 

39. Double click the Explode View to access it’s Format dialog 

40. Click PCB Data Tab.  Select to turn on Top-side Routes and change the color of 
the routes to RED.   Select OK in the format dialog.  You see that the explode 
view can support different settings in the detail than those in the PCB image. 

41. Select Previous View or Fit Sheet to view the entire drawing sheet 
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Import a DXF file 
42. Display the Task Pane  

43. Change the Task pane from the New Drawing Menu to the Imported Files menu. 

44. Select File – Import – DXF…  from the main menu and browse to select the 
DXF file:  “Your BluePrint Demo Installation Folder/Demo Files/Imported 
Files/DXF Files/Auxilary Face Plate – Side View.dxf”.  Select Open to Import the 
file.   The imported file will become visible in the imported task pane.  This file will 
also be saved with the release package when you save the BluePrint file. 

45. Drag and drop the faceplate to the left of the Top Side Image.  

46. With the DXF item selected display the RMB and select CONVERT 

47. You have now converted the DXF element into BluePrint constructs. Click the 
edge of the faceplate and a rectangle should be selected.  You can import data 
from DXF and modify in BluePrint and store it in the BluePrint gallery. 

48. Area Select all the former DXF lines, then click the GROUP  function from the 
drafting tool bar. The entire DXF item is now converted to a BluePrint group, 
which makes it easier to work with.  

Create a Custom Drawing 
Gerber images can be imported. 

49. Create a New Custom Drawing from the Main tool bar and Task Pane:  

50. Add Sheet Border, Title Block, Revision Block from the Common Elements 
Palette. 

51. File – Import – Gerber and select “Your BluePrint Installation Folder/Demo 
Files/Imported Files/Gerber Files/sst001026.pho”. The file will appear in the 
Imported Files Task Pane. 

52. Drag and drop the image onto the drawing. 

53. Resize as needed. 

Create a custom Title Block with your company’s logo  
54. Select the Common Elements Drawing Palette and Drag and Drop a Title Block 

onto a drawing sheet that does not have a Title Block.   

55. Select Insert – Picture… and browse to select “Your BluePrint Installation Folder 
/Demo Files/Imported Files/Multi-Media Files/Graphic Files/DownStream – 
Primary.bmp”. 

56. The company logo will become visible in the Imported task pane.  Drag and Drop 
the logo and place and size it as you like on the title block drawing element on 
the drawing sheet.  

57. Select Save to Gallery from the company logo graphic’s context menu and save 
it to the Element Gallery.  
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58. Select the title block table you have created, move your cursor over the cell in 
which you want to place the company logo graphic and select Format Cell from 
the context menu. Select the Cell tab in the Format Cell dialog and select 
Drawing Element from the content type drop-down menu.  Select OK on the 
Format Cell dialog. 

59. With your cursor over the cell in which you would like your company logo, select 
Edit Cell from the context menu.   

60. Select the Element Gallery button on BluePrint's Gallery toolbar and drag and 
drop the company logo graphic from the Element Gallery onto the cell in your title 
block table which you just put in Edit mode.  Select on the drawing sheet outside 
the title block table (a message may appear asking if you want to close the 
drawing element.  Select Yes. )  The company logo graphic is now associated 
with the title block. 

61. Select the Title Block and Save to the Element Gallery under a new name and 
the folder “Default Element Gallery/Templates/Nomenclature/Title Block”. 

62. Now LMB single select the Title Block element in the Common Elements Tool 
Palette.  The Title Block dialog will show you both the original Title Block and the 
new Title Block elements.  Select your new Title Block and select Set as Default 
on the dialog and then select OK.  Your new Title Block will now be used when 
you Drag and Drop a Title Block element onto a drawing sheet.  
 

63. Select Edit Cell from the context menu to modify the placement or scale of the 
company logo graphic in the title block. 

Hyperlinks  
64. Select the Common Elements Drawing Palette and Drag and Drop a Text Block 

onto your drawing sheet.   

65. In the Text Box type “Visit this web page for part availability”.   

66. Select the text and RMB and select Hyperlink.  Choose the URL icon and type in 
your favorite website (for example: www.downstreamtech.com).  Under Tooltip 
type “Part Availability” and select OK on the dialog. 

67. Change the workspace window to Preview mode and place the cursor over the 
text.  You will see the Tool tip appear.  Select the text and you will be brought to 
the website you entered in the hyperlink dialog using Internet Explorer.    

68. BluePrint links technology can create live and interactive documentation that 
provides more detailed instructions and is far easier to navigate than 
conventional hardcopy or PDF. BluePrint documents act like web pages.  You 
can link to a website, an external document, an internally embedded document or 
drawing element, and to email.   
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Instant ECOs 
BluePrint’s Patent pending technology for linking the PCB CAD data to the 
documentation can create instant ECO changes. 

69. Select Side-by-Side sheet views so you can see all 3 drawing sheet you have 
created.  Import “Your BluePrint Demo Installation Folder/Demo Files/BluePrint 
Demo Rev 2” ASCII file 

a. When the auto-update dialog appears, you can control what PCB views 
get refreshed and which are left alone. 

b. The PCB images are updated, layer stack, drill chart, parts list, Variant 
displays, and panel 

c. There are no limits on how many imports can be done. BluePrint reflects 
any imported CAD data without the typical PCB design constraints 

d. BluePrint can detect changes to the ASCII file to inform the designer of 
changes. The PCB load indicator in the lower right will change to Yellow if 
file is out of synch. 

BluePrint Publish to the Web Demo 
BluePrint exports data via HTML and with an Active X control allows viewing of BluePrint 
documents over the web through Internet Explorer 

70. From the File Menu select “Publish to Web…”   For file location, send to the 
Desktop 

OUTSIDE OF BLUEPRINT… 
71. Locate the HTML file created on your desktop.  

72. Double-Click on the HTML file. 

a. Navigate through the demo package through Internet Explorer 

b. There is also a Stand Alone BluePrint Viewer application that allows 
unlimited viewing as well as querying of design data and extraction of 
files. 

What else can BluePrint do? 
Much more!  Contact us at 800 535 3226 or sales@downstreamtech.com  

 Parts List Management and display 

 Variant definition and display 

 Process Step definition and display 

 Create document templates that can be reused for every design 

 Create a single Release Package depository for all product creation files 

 Full 2D drafting and dimensioning tools 

 Customize the User Interface 

 And more…. 


